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NEW QUESTION 1
- (Topic 3)
When a flow runs an action, it generates a runtime value, which stays the same for the duration of the flow. What is the name of this runtime value?

A. Trigger runtime value

B. Sequence runtime value
C. Starting runtime value
D. Data pill runtime value
E. Input runtime value

Answer: D
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/flow-designer/concept/data-population.html

NEW QUESTION 2
- (Topic 3)
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As: Configure >

Export )
Cond View >

Create Favorite

Copy URL

Copy sys_id
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Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table

B. The Form Context menu > Configure > Table

C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 3

- (Topic 3)

While testing a Catalog Item for ordering an expensive computer, the mandatory approval is being skipped for requester Bob, Smith, but not for any of the other
requesters. What could explain the issue?

A. There is a business rule, excluding Bob.Smith from any approvals.
B. Bob Smith does not have a delegate set up on his account,

C. The Bob Smith user account, does not have a manager specified.
D. The manager does not have a delegate assigned,

E. Bob Smith is a VIP.

Answer: A

NEW QUESTION 4

- (Topic 3)

What are the three key tables in an enterprise CMDO? Choose 3 angwers

A. sn_cmdt_bak
B. Sh_emdb_ci
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C. cmap_ret_ci
D. cmdb_bak
E. cmdb_ci

F. sh_eomdb
G. cmap

Answer: CEG

NEW QUESTION 5

- (Topic 3)

While showing a customer their incident form, they ask to change the Priority field title to display their internal terminology PValue. How would you do that? Choose
2 answers

A. Right click on Priority and select Configure Dictionary

B. Right click on Priority and select Configure Display Settings
C. Right click on Priority and select Configure Label

D. Right click on Priority and select Configure Column

Answer: AC

NEW QUESTION 6
- (Topic 3)
When building an extended table from a base table, which fields do you need to create? Choose 2 answers

A. The mandatory fields for the base table.

B. The reference fields for the base table.

C. The fields that are not in the base table.

D. The fields that are specific to the extended table.

Answer: CD

NEW QUESTION 7
- (Topic 3)
From a related list, what would a user click for personalize the layout of the columns?

A. Magnifier

B. Context Menu
C. Pencil

D. Gear

Answer: D

NEW QUESTION 8
- (Topic 3)
On the Form header, which icon do you use to access form templates?

A. Paperclip

B. Pages

C. Stamp

D. More Options {...)

Answer: D

NEW QUESTION 9
- (Topic 3)
User records are stored in which table?

A. User [sys_user]
B. User [sn_user]

C. User [u_sys_user]
D. User [s_user]

Answer: A
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/concept/c_UserPreferences.html

NEW QUESTION 10

- (Topic 3)

Which type of scripts nun in the browser?
A. Script include Scripts

B. Business Rule Scripts

C. Access Contra! Scripts

D. Ul Policies and Client Scripts

Answer:
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D

NEW QUESTION 10
- (Topic 3)
What section on a task record is used to see the most recent updates made to a record?

A. Related List

B. Activity Stream
C. Audit Log

D. Timeline

Answer: B

NEW QUESTION 13
- (Topic 3)
When using the Data Pill Picker, use which keys to dot-walk (6 fields in other tables?

A. Arrows

B. Plus, Minus

C. Ctrl c, Ctrl

D. Ctrl <, Ctrl >

E. Shift F4, Shit FS

Answer: A

NEW QUESTION 17
- (Topic 3)
On what part of the ServiceNow instance, would you find the option to access applications, like Incident Management?

A. Self Service Module

B. Application Navigator

C. Service Desk Homepage
D. Favorites

Answer: B

NEW QUESTION 20
- (Topic 3)
In what order are Access Controls evaluated?

A. Field-level - mast general to most specific: then Row-level - most specific to most general
B. Table-level - most specific to most general; then Row-level - most specific to most general
C. Table-level - most specific to most general; then Field-level « most specific to mast general
D. Field-level - most specific to most general: then Table-level - most specific to most general

Answer: D

NEW QUESTION 25

- (Topic 3)

A manager wants to view a snapshot of month-end Sales performance data, as compared to Sales targets. In addition, the manager wants to be able to see those
monthly numbers trended over time, and

forecasted into the future. What capability do you suggest for this manager?

A. Scheduled Reports, a custom snapshot table, and a Trend report

B. Scheduled Reports and Excel

C. Scheduled Reports, a custom snapshot table, and a Projection report
D. Performance Analytics

E. Key Performance Indicators

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/performance-analytics/concept/c_ForecastingData.html

NEW QUESTION 27

- (Topic 3)

For your implementation, the following tables. are extended fram each ofher:

* Incident table is extended from Task table.

* Super Incident table is extended from Incident table,

In this situation, which table(s) are P arent, Child and Base tables? Choose 5 answers

A. Incident table is a Base table

B. Incident table i

C. a Parent table

D. Incident table is a Child table

E. Super Incident table is a Child table
F. Super Incident table is a Parent table
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G. Super Incident table is a Base table
H. Task table is a Base table

I. Task table is a Parent table

J. Task table is a Child table

Answer: BCDGH

NEW QUESTION 28

- (Topic 3)

The ServiceNow platform supports a wide variety of plus-and-play application. You can

choose from the included workflow or build your own workflow. Which of following these workflows are included in the platform?

A. Employee Workflows

B. Infrastructure Workflows
C. Federal Workflows

D. Manufacturing Workflows
E. Customer Workflows

F. IT Workflows

Answer: AEF

NEW QUESTION 30

- (Topic 3)

You have been asked to configure a form so an employee could a tablet and select the

standard accessary options to purchase with it. These standard options are: carrying case, screen cleaner, tablet stand, and screen protector. What approach
would you take?

Choose 3 answers

A. Create Catalog item for the tablet, and on the form, add a check box variable for each accessary option.

B. Create Catalog item for the tablet, and add a variable set to the form, for the accessary options.

C. Create one Catalog item for each: tablet, carrying case, screen cleaner, tablet stand, and screen protector.
D. Create a Records producer, and on the form, add a check box variable for each accessary option.

E. On shopping Cart configuration, select option to show the Add Accessories button.

Answer: ABC

NEW QUESTION 35
- (Topic 3)
Which framework can automatically populate values for the priority and Category field based on the Short description field value?

A. Ul Policy

B. Assignment Rule

C. Action

D. Predictive intelligence
E. CSDM

Answer: A

NEW QUESTION 37
- (Topic 3)
What are the components that make up a filer condition? Choose 3 answers

A. Column

B. Match Criteria
C. Field

D. Value

E. Operator

Answer: C

NEW QUESTION 41
- (Topic 3)
When you set a policy that is applied to all data entered into the platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Client
B. Server
C. Browser
D. Network

Answer: B

NEW QUESTION 44

- (Topic 3)

Tables may have a One to Many relationships. From the Service Catalog, what are examples of tables having a one to many relationships? (Choose three.)

A. One Approval can have many Requests
B. One Request can have many Requested Items
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C. One Requested Item can have many Approvals
D. One Requested Item can have many Catalog Tasks
E. One Cart can have many Requests

Answer: BDE

NEW QUESTION 47
- (Topic 3)
On Access Control Definitions, what are ways you can set the permissions on a Table? Choose 3 answers

A. Groups

B. CRUD

C. Roles

D. Script that sets the answer variable to true or false
E. Conditional Expressions

Answer: CDE

NEW QUESTION 50
- (Topic 3)
Which action enables personalization in a form for the admin role, only?

A. Navigate to sys_form_properties.list and set the property glide.ui.enable_personalize_form.admin to true.

B. Navigate to Context Menu > Configure > Form Layout and select 'Enable Personalization' and Enter the ‘admin’ role.
C. Navigate to Context Menu > Configure > Table and add the role 'Admin' in the 'Available User' list box.

D. Navigate to sys_properties.list find the property glide.ui.personalize_form.role and set the Value to admin.

Answer: D

Explanation:

This action allows only users with the admin role to personalize forms by using the Personalize Form buttonl. The other options are either invalid or do not restrict
personalization to the admin role only.

ReferencesPersonalize a formUI settings and personalizationPersonalization

NEW QUESTION 51
- (Topic 3)
On a Business Rule, the When salting determines at what point the rule executes. What are the options for specifying that timing?

A. Insert, Update, Delet

B. Query

C. 4G} Before, After, Async, Display

D. Prior to, Synchronous, on Update

E. Before, Synchronous, Scheduled Job, View

Answer: B

NEW QUESTION 53
- (Topic 3)
Tables may be set up with Many to Many relationships. What is a classic example of a scenario where the tables would have many to many relationships?

A. Requests can contain many items; and Items can be any item from the catalog.

B. Vendors can sell multiple products; and products can be sold by multiple vendors.

C. A Task can trigger many Workflows; and a Workflow can trigger many Tasks

D. A Configuration Item can belong to multiple Classes; and Classes can contain multiple Configuration Items.

Answer: B

NEW QUESTION 58
- (Topic 3)
What action will allow you to personalize layouts of columns in a list?

A. Click Gear icon > Personalize window options > Select the appropriate columns

B. Select the column to be personalized > Click Edit icon (Penal) > Choose me options to personage
C. Context Menu > View > Personalize

D. Select the column to be personalized and right at the header > Choose the options to personalize

Answer: A

NEW QUESTION 62

- (Topic 3)

When adding a related list to a form, you choose the related list from the list callector, What is an example of a related list you might see on the list collector?
Choose 3 answers:

A. Release Phase==Parent
B. Catalog Task->Parent
C. HR Case-=Parent

D. Problem==Parent
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E. Outage->Task number

Answer: BCE

NEW QUESTION 67
- (Topic 3)
Which statement correctly describes the differences between a Client Script and a Business Rule?

A. A Client Script executes before a record is loaded and a Business Rule executes after a record is loaded
B. A Client Script executes on the server and a Business Rule executes on the client

C. A Client Script executes on the client and a Business Rule executes on the server

D. A Client Script executes before a record is loaded and a Business Rule executes after a record is updated

Answer: C

Explanation:

Reference: https://community.servicenow.com/community?id=community _question&sys_id=77a80361
db5cdbc01dcaf3231f9619d9#:~:text=The%20major%20difference%20between%200f,delet
ed%2Fqueried%20from%20data%?20base.&text=After%20that%2C%20the%20Client%20s cripts,Client%20scripts%20that%20work%20onSubmit

NEW QUESTION 68
- (Topic 3)
What feature do you use to specify which users are able to access a Service Catalog Item?

A. Can Read Role

B. Catalog User Role
C. Can Order Tab

D. User Criteria

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow- platform/page/product/service-catalog-management/task/t_AppUserCrititemsCat.html

NEW QUESTION 70

- (Topic 3)

Which feature enables business process owners to organize Flow Designer content into unified and digitized cross-enterprise processes via a digitized task board
Interface?

A. Flow Designer

B. Process Automation Designer
C. Process Workflow Designer
D. Workflow Editor

Answer: B

NEW QUESTION 74
- (Topic 3)
Which tables are children of the Task table and come with the base system? Choose 3 answers

A. Incident

B. Problem

C. Change Request
D. Config

E. Dictionary

F. cmdb

Answer: ABC

Explanation:

The Task table is a base table in ServiceNow, which means it is not extended from any other table. However, other tables can extend the Task table to inherit its
fields and functionalities. Incident, Problem, and Change Request are all child tables of the Task table, meaning they inherit the fields and functionalities of the
Task table and add their own specific fields and functionalities.

References

? https://docs.servicenow.com/bundle/vancouver-platform-administration/page/administer/task-table/concept/c_TaskTable.html

? https://www.servicenow.com/community/now-platform-forum/parent-table-to-get-an-access-to-child-table-column/m-p/1133982

? https://www.servicenow.com/community/developer-forum/difference-between-a-base-class-and-base-table/m-p/1618247

NEW QUESTION 78
- (Topic 3)
When importing spreadsheet data into ServiceNow, in which step does the data get written to the receiving table?

A. Run Transform

B. Run Import

C. Import Dataset

D. Execute Transform
E. Schedule Transform
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Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/paris-platform-administration/page/script/server-scripting/task/t_CreatingAFieldMap.html

NEW QUESTION 79
- (Topic 3)
To apply a Ul Palicy to all views, which field should be set to true in its definition record?

A. Inherit

B. Reverse if false
C. On lowed

D. Global

Answer: A

NEW QUESTION 81

- (Topic 3)

An IT user calls the service desk because they need to work on task records. All they can see is Self Service on their homepage when they login to the
ServiceNow instance. What issue could explain this? Choose 2 answers

A. Their user account failed LDAP authentication

B. Their user account is not logged in properly

C. Their user account was not approved by their manager

D. Their user account does not have itil role

E. Their user account does not belong to any groups, which contain the itil role

Answer: AC

NEW QUESTION 83

- (Topic 3)

You have heard about a new application released by SericeNow, You want to try it out, to- see if it might be useful for your company's ServiceNow implementation.
What would be the best way to get hands-on experience with the new application?

A. Check the latest release notes at docs.servicenow.com.

B. Activate the application plug in, on your personal dev instance.

C. Search the wiki for the sales demo request form,

D. Activate the application plug in, on your company's production instance.

Answer: B

NEW QUESTION 86

- (Topic 3)
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the associated record?
- INCident
{ = INco010112 -f
Number INCDOL0112
> Caller survey user Q. o5 (0
Category Inquiry / Help W
Subcategory None "

A. Drilkdown
B. Lookup
C. Quickview
D. Preview
E. Snapshot

F. Reference:

Answer: F

NEW QUESTION 89

- (Topic 3)

What icon do you use to change the icon and color on a Favorite’?

A. Star

Passing Certification Exams Made Easy visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 P QsseaQs LJ https://www.2passeasy.com/dumps/CSA/ (371 New Questions)

B. Triangle
C. Pencil
D. Clock

Answer: C

NEW QUESTION 94

- (Topic 3)

If users would like to locate and assign a task to themselves in the Platform, What action could they perform from the list view to make the assignment?
Choose 2 answers

A. Select the record using the check box, then select the Person icon

B. Double click on the Assigned to value, type the name of the user, and select the green check

C. Select the record using the check box then select the Assign To Me Ul action on the List Header
D. Right click on the Task number and select the Assign to me option in the menu

E. Select the Task number, and select the Assign to me Ul action on the form

Answer: DE

NEW QUESTION 97
- (Topic 3)
ServiceNow contains over 25 different report types. What are some of the types? Choose 5 answers

A. Pie

B. Speedometer
C. Odometer

D. Thermometer
E. Horizontal Bar
F. Semi-Donut
G. Donut

Answer: ABEFG

NEW QUESTION 101
- (Topic 3)
When an administrator sets a policy that is applied to all data entered into the Platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Network
B. Server
C. Client
D. Browser

Answer: B

Explanation:

A policy that is applied to all data entered into the Platform is called a Data Policy. Data policies run on the server side and enforce data consistency by setting
mandatory and read-only states for fields1.

ReferencesData policies

NEW QUESTION 102
- (Topic 3)
Which best describes a field in a SeniceNow table?

A. A field is a table cell that stores data

B. A field is a table row

C. Afield is an item that appears in a menu list
D. A field is a record in a table

Answer: C

NEW QUESTION 106
- (Topic 3)
Many actions are included with flow designer, what are some frequently used core actions? Choose 4 answers.

A. Wait for Condition
B. Ask for Approval
C. Create Record

D. Wait for Match

E. Look for Update
F. Look Up Record

Answer: BCDF

NEW QUESTION 111
- (Topic 3)
What are the steps for importing data using an import set?
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A. Select source file; Run automap; Transform data; Clean up target table

B. Set up LDAP; Test map: Create update set; Run import: Apply update set

C. Identify source; Import transform map: Run transformer; Verity import

D. Load the data; Create transform map; Transform data; Clean up import table

Answer: D

NEW QUESTION 112

- (Topic 3)

Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that applies to the entire Incident table (all rows and
fields)?

A. incident .*
B. incident.all
C. incident .!
D. incident.None

Answer: A

Explanation:

The object name for a rule that applies to the entire Incident table is incident

*, which means any field on the incident table. The other options are not valid object names for access control rules.
ReferencesAccess control list rulesAccess Control List in ServiceNowAccess Controls

NEW QUESTION 113
- (Topic 3)
When importing spreadsheet data into ServiceNow, what is the first step in the process?

A. Create Import Set
B. Run Data Scrubber
C. Set Coalesce

D. Define Data Source
E. Select Import Set

Answer: A

NEW QUESTION 114
- (Topic 3)
After you create a new table, what is the best practice regarding the navigation pane? Choose 2 answers

A. Set the filter condition on the Application Menu

B. Set the font style on both the Application Menu and the Module
C. Specify which Roles are able ta see the Module

D. Specify which Roles are able to see the Application Menu

E. Create Application Menu with the same name as the table label
F. Create Module with the plural of the table label

Answer: CD

NEW QUESTION 118
- (Topic 3)
What instance resource allows you to access guided tours, information about actions, and instructions an how to use inputs and outputs in your flaw?

A. Community

B. Help Panel (question mark icon)
C. Docs

D. Wiki

Answer: B

NEW QUESTION 120

- (Topic 3)

Which ServiceNow utility provides a modern interactive graphical interface to visualize
configuration items and their relationship?

A. CSDM Schema

B. Business Service Map
C. Dependency View

D. CI Class Map

Answer: D
NEW QUESTION 123
- (Topic 3)

What type of field has a drop down list, from which you can pick from pre-defined options?

A. Choice
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B. Picker
C. Drop down
D. Option

Answer: A
Explanation:

Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0538947

NEW QUESTION 128
- (Topic 3)
Which element is used to track items not saved with a field, in a record?

A. Sidebar

B. List Editor

C. Activity formatter
D. Dictionary

Answer: C

Explanation:

The activity formatter provides an easy way to track items not saved with a field in the record, such as journal fields like comments and work notes1.

ReferencesFormatters and Related Lists

NEW QUESTION 129
- (Topic 3)
What is the most common role that has access to almost all platform features, functions, and data?

A. Security Admin [security_admin]
B. Sys Admin [sys_admin]

C. Admin [sn_admin]

D. System Administrator [admin]
E. Base Admin [base_admin]

Answer: C

Explanation:

Reference: https://developer.servicenow.com/dev.do#!/guides/quebec/now-platform/glossary/developer-glossary

NEW QUESTION 132
- (Topic 3)
What is the primary objective of the Display Business Rule?

A. To monitor fields on a form, and provide feedback

B. To use a shared g_scratchpad object, which can be sent to the client, as part of the form
C. To set files to mandatory, hidden, and read-only

D. To define what happens on a form, when a particular fled changes

Answer: B

NEW QUESTION 136

- (Topic 3)

Access controls are evaluated in this order:

* 1. Match object against table ACL

* 2, Match the object against field ACL

Within step 1 above, what order are the table ACLs evaluated?

A. Specific to general: Table.Field ACL, Parent Table.Field ACL, *.Field ACL
B. Bottom to top: Table AC

C. Table.Field ACL, Parent Tabl

D. Field ACL

E. General to specific: Table ACL, Table.Field ACL, Parent Table, Field ACL
F. Top to bottom: Wildcard Table ACL, Parent Table ACL, Table ACL

G. Specific general: Table ACL, Parent Table ACL, Wildcard (*) ACL

Answer: E

NEW QUESTION 138
- (Topic 3)
What type of query allows you to filter list data using normal words, instead of the condition builder?

A. Natural Language Query

B. Alexa Query

C. Machine Learning Query

D. Predictive Intelligence Query
E. Auto-suggest Query

Answer:
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A

NEW QUESTION 143
- (Topic 3)
What is used to determine user access to knowledge bases or a knowledge article?

A. sn_kb_read, sn_article_read
B. Privacy Settings

C. Read Access Flag

D. User Criteria

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 145
- (Topic 2)
On a Form header, what is the three bar icon called?

A. Pancake icon

B. Additional Actions or Context Menu
C. Hamburger icon

D. Cake icon

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-forms/concept/c_FormContextMenu.html

NEW QUESTION 146
- (Topic 3)
When importing data, what happens to imported rows, if no coalesce field is specified?

A. All rows are rejected from the import, as coalesce field is required.

B. All rows are treated as new record

C. No existing records are updated.

D. Duplicate rows are rejected from the import.

E. All rows are treated as new records, but errors will be flagged in the import log.

Answer: D

Explanation:
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 150
- (Topic 2)
When creating a global custom table named “abc”, what is the table name that is automatically assigned by the platform?

A. snc_abc
B. abc
C.u_abc
D. sys_abc

Answer: C

NEW QUESTION 151
- (Topic 2)
What is the difference between a Ul Policy and Data Policy?

A. Data Policies run only after Ul Policies run successfully

B. Data Policies run regardless of how data is entered Into ServiceNow, while Ul Policies are used for form interactions

C. Data Policies can be converted into Ul Policies, but Ul Policies can not be converted into Data Policies

D. Data Policies run when data is entered through the form, by an Import Set or by web services, while Ul Policies are set only by web services

Answer: D

NEW QUESTION 155
- (Topic 2)
What are three security modules often used by the System Administrator? (Choose three.)

A. System Properties > Security

B. Utilities > Migrate Security

C. System Security > Security

D. Self-Service > My Access

E. System Security > Access Control (ACL)
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F. Password Management > Security Questions
G. System Security > High Security Settings

Answer: AEG

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/reference/r_GeneralSecuritySettings.html

NEW QUESTION 156

- (Topic 2)

ServiceNow contains a resource which provides the following:

A standard and shared set of service related definitions across ServiceNow products and platform that will enable and support true service level reporting.
A CMDB framework across our products and platform that will enable and support multiple configuration strategies.

What resource do these statements describe?

A. Common Services Data Model (CSDM)

B. Information Technology Service Management (ITSM)
C. Configuration Management Database (CMDB)

D. Information Technology Infrastructure Library (ITIL)

Answer: A

Explanation:
Reference: https://www.servicenow.com/content/dam/servicenow-assets/public/en-us/doc-type/resource-center/solution-brief/sbr-servicenow-common-service-data-
model.pdf

NEW QUESTION 161
- (Topic 2)
From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout

B. Context Menu > Configure > Form Layout

C. Context Menu > Configure > Form Design

D. Right click on header > Add > Field

E. Context Menu > Form > Designer

F. Right click on header > Configure > UX Dashboard

Answer: BD

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 166
- (Topic 2)
What is an Event in ServiceNow?

A. An Event is a trigger that has a direct response in the platform

B. An Event is an indication to the ServiceNow processes that something has occurred
C. An Event is an indicator that a Priority 1 (P1) Incident has been logged

D. An Event is a recognized, scheduled occurrence of a process

Answer: B

NEW QUESTION 168

- (Topic 2)

A new service catalog item is being developed, but should only be visible to managers inside the HR Department. What method would you use to fulfill this
requirement?

A. Specify the Dept_Mgr role on the catalog content block

B. Add the Department Manager group to the catalog item’s user criteria
C. Add the Department Manager group to the catalog item’s ACL

D. Only publish the item in the HR service catalog

E. Use a Dept_Mgr ACL on the HR service catalog

Answer: C

NEW QUESTION 172

- (Topic 2)

Which tool should be used to populate commonly used fields in a form?
A. Template

B. Reference Qualifier

C. Formatter

D. Assignment Rule

Answer: A
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NEW QUESTION 173
- (Topic 2)
What is a quick way to create a report from a list view?

A. Click on filter breadcrumb, drag and drop on the Report > Create New module
B. Click Funnel, define filter conditions, click Create Report

C. Click Context Menu, select Create Report

D. Apply filter, right click on column header, select Bar Chart

E. Apply filter, right click on column header, select Create Report

Answer: B

Explanation:
Reference: https://ut.service-now.com/sp?id=kb_article&number=KB0014148

NEW QUESTION 176
- (Topic 2)
Which module would you use to create a new automation of business logic such as approvals, tasks, and notifications?

A. Process Automation > Flow Designer

B. Process Automation > Flow Administration
C. Process Automation > Workflow Editor

D. Process Automation > Process Flow

E. Process Automation > Active Flows

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/process-automation-designer/concept/getting-started-process-
automation.html

NEW QUESTION 178
- (Topic 2)
New records, new groups, and modified configuration Items (Cls): what do they have in common?

A. They are included in an Update Set

B. They are not captured in an Update Set
C. They are customizations

D. They do not have anything in common

Answer: A

NEW QUESTION 179

- (Topic 2)

What is the name of the table relationship, where two or more tables are related in a bi- directional relationship, so that the related records are visible from both
tables in a related list?

A. Database View
B. Many to Many
C. One to Many
D. Extended

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-data/concept/c_DataManagement.html

NEW QUESTION 183
- (Topic 2)
Which plugin needs to be activated in order to translate the content of a catalog item to multiple languages?

A. Localization Framework plugin (com.glide.localization_framework)

B. Translation Framework plugin (com.glide.translation_framework)

C. Multiple Language Framework plugin (com.glide.multiple.language_framework)
D. Language Al Framework plugin (com .g | id

E. language.ai _framework)

Answer: A

NEW QUESTION 186
- (Topic 2)
What do you call any component that needs to be managed in order to deliver services?

A. CSDM ltems

B. CMDB

C. Configuration item
D. Service Offerings
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E. Asset

Answer: C

Explanation:
Reference: https://infocenter.io/servicenow-cmdb-implementation/

NEW QUESTION 188
- (Topic 2)
What is used frequently to move customizations from one instance to another?

A. Update Sets

B. Code Sets

C. Update Packs

D. Configuration Logs
E. Remote Sets

F. Local Sets

G. Code Packs

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-it-operations-management/page/product/service-mapping/task/export-patterns.html

NEW QUESTION 193
- (Topic 2)
What is NOT an example of a Ul Action?

A. Search

B. Form buttons
C. list Buttons
D. Related Links

Answer: C

NEW QUESTION 194
- (Topic 2)
What do you activate when you want to add applications or functionality within your development instance?

A. App Package

B. Updated Pack

C. Patch

D. Plugin

E. App Updated Set

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/plugins/concept/c_ServiceNowPlugins.html

NEW QUESTION 199
- (Topic 2)
Which of the following are not included in an Update Set, by default? (Choose four.)

. Homepages

Data

. Published Workflows
. Business Rules

. Schedules

. Database changes
. Related Lists

. Report Definitions
I. Scheduled Jobs

J. Client Scripts

K. Views

IOTMUO®>

Answer: ABEF
Explanation:

Reference: https://docs.servicenow.com/bundle/paris-servicenow- platform/page/administer/workflow-
administration/concept/c_WorkflowMovementWithUpdateSets.html

NEW QUESTION 203
- (Topic 2)
What are the components that make up a filter condition? (Choose three.)

A. Operator
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B. Match Criteria
C. Value

D. Column

E. Field

Answer: ACE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_Filters.html

NEW QUESTION 207
- (Topic 2)
What controls the publishing and retiring process for knowledge articles?

A. Approval Policies
B. Approval Definitions
C. Workflow Designer
D. Workflows

E. State Lifecycle

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/reference/r_KnowledgeWorkflows.html

NEW QUESTION 212

- (Topic 2)

Your customer would like to create a new template to notify users who are affected by network outages at their site. Which module would you use to create a new
notification?

A. System Notification > Email > Notifications
B. Administration > Notification Overview

C. System Properties > Email > Settings

D. User Preferences > Email > Notifications
E. Click Gear > Naotifications > New

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/notification/task/t_CreateANotification.html

NEW QUESTION 215
- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?

A. Activate application trigger spoke

B. Activate trigger security rules

C. Activate application spoke, and plug-ins as needed

D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only

Answer: B

NEW QUESTION 218
- (Topic 2)
What kind of data can Import Sets use to populate tables in ServiceNow?

A. CSS, SOAP, and Excel
B. XM

C. CSV, and Excel

D. SOAP, REST, and XML
E. XML, SOAP, and CSS

Answer: B

Explanation:
https://docs.servicenow.com/bundle/orlando-platform-administration/page/administer/import-sets/concept/c_ImportDataUsinglmportSets.html

NEW QUESTION 221

- (Topic 2)

The ServiceNow Virtual Agent provides assistance within a messaging interface. Which capability allows end users to configure virtual Agent to intercept and help
resolve submitted incidents?

A. Incident Auto-Resolution
B. Ticket Resolver

C. Virtual Agent Helper

D. Web Intelligence
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Answer: A

NEW QUESTION 226

- (Topic 2)

Which certificate-based authentication methods can be enabled so that users can log into the Service Portal? (Select all that apply) Select 2 Answers from the
below options

A. Extended Validation Access (EVA)
B. Organization Verification Card (OVC)
C. Common Access Card (CAC)

D. Domain Authentication Card (DAC)
E. Personal Identify Verification (PIV)

Answer: CE

NEW QUESTION 227

- (Topic 2)

A user wants to create a set of filter conditions, where they want to show records which satisfy two conditions:
Incidents where the state is Closed

Incidents where Assignment Group is Network

After clicking the Funnel icon, what should the user do?

A. Define the first condition; click AND button; define second condition; click Run

B. Define the first condition; click AND button; define second condition; press enter

C. Define the first condition; click OR button; define second condition; press enter

D. Define the first condition; click > icon on breadcrumb, define second condition; click Run
E. Define the first condition; click > icon on breadcrumb, define second condition; press enter

Answer: A

NEW QUESTION 231
- (Topic 2)
What is the purpose of the Event Registry?

A. The Event Registry lists all Events that have successfully completed within a 24-hour period

B. The Event Registry is a list of all Events that originate through an integration

C. The Event Registry is a module that provides Event definitions

D. The Event Registry is a list of all Events that have successfully completed after being Invoked by a script

Answer: A

NEW QUESTION 235
- (Topic 2)
How are local flow variables accessed in the Flow Designer Data panel?

A. As newly generated icons
B. As scratchpad variables
C. As new tabs

D. As data pills

Answer: D

NEW QUESTION 236
- (Topic 2)
What are two ways to generate an Event? (Choose two.)

A. Business Rule

B. Workflow

C. Log entry

D. Knowledge article publication

Answer: AB

NEW QUESTION 241
- (Topic 2)
Which module is used as the first step for importing data?

A. Coalesce Data
B. Transform Data
C. Import Data

D. Load Data

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/paris-platform-administration/page/administer/import-sets/concept/c_ImportDataUsinglmportSets.htm
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NEW QUESTION 245
- (Topic 2)
Which feature allows you to automate business logic for a particular application or process such as approvals, tasks notifications, and record operations?

A. Flows

B. Action Sequences
C. Action Sets

D. Task Flows

E. Flow Diagrams

Answer: E

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/flow-designer/concept/flow-
designer.html#:~:text=the%20following%20components%3A-,Flows,a%20particular¥%20application%200r%20process

NEW QUESTION 247
- (Topic 2)
In addition to the admin role, which one of the following roles allows a user to add or remove fields from a list?

A. personal ize.control
B. personal_list

C. ul_page_admin

D. ui_action_admin

Answer: A

NEW QUESTION 251
- (Topic 2)
Which ServiceNow capability provides assistance to help users obtain information, make decisions, and perform common work tasks via a messaging interface?

A. Agent Workspace
B. Chat bot

C. Virtual Agent

D. Knowledge Chat
E. Now Support

Answer: C

NEW QUESTION 255
- (Topic 2)
How can administrators utilize the same content for different notification channels?

A. Configure Default notification content
B. Enable Actionable notification content
C. Provide Common notification content
D. Set up Related notification content

Answer: C

NEW QUESTION 259
- (Topic 2)
Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log

C. Access Control Rules

D. Application Scope

Answer: D

NEW QUESTION 264
- (Topic 1)
When searching using the App Navigator search field, what can be returned? (Choose four.)

A. Names of Applications and Modules
B. Names of Modules

C. Names of Applications

D. Favorites

E. History Records

F. Titles of Dashboard Gauges

Answer: ABCD

NEW QUESTION 265
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- (Topic 2)
Which tool is used to define relationships between fields in an import set table and a target table?

A. Transform Schema
B. Schema Map

C. Dictionary Map

D. Transform Map

E. Field Transformer
F. Import Designer

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/import-sets/concept/c_ImportSetsKeyConcepts.html

NEW QUESTION 266
- (Topic 2)
What is a role in ServiceNow?

A. A role is one record m the Role [sys_user_role] table
B. A role is one record in the Role luser_sys_role] table
C. Arole is a persona used In Live Feed Chat

D. Arole Is a set of modules for a particular application

Answer: A

NEW QUESTION 269
- (Topic 2)
What function do you use to add buttons, links, and context menu items on forms and lists?

A. Ul Policies
B. Ul Settings
C. Ul Actions
D. Ul Config

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/concept/c_UIActions.html

NEW QUESTION 273
- (Topic 1)
What are the 5 provided Roles by ServiceNow?

A. System Administrator: The admin role provides access to all platform features, applications, functions and data.

B. Specialized Administrator: Specialized administrator roles manage specific functions or applications, such as Assignment Rules, Knowledge base, reports, or
web services

C. Fulfiller: Users with the ITIL role may fulfill ITIL activities associated with the ITIL workflow, including Incident and Change management.

D. Approver: Users with the Approver user role can perform all requester actions and may view or modify approval records directed to the approver

E. Requester: Also known as Employee Self Service (ESS) users, these users have no roles but can submit and manage their own requests, access public pages,
etc.

Answer: ABCDE

NEW QUESTION 274
- (Topic 1)
What information does the System Dictionary contain?

A. The human-readable labels and language settings
B. The definition for each table and column

C. The information on how tables relate to each other
D. The language dictionary used for spell checking

Answer: B

NEW QUESTION 275

- (Topic 1)

A knowledge article must be which of the following states to display to a user?
A. Published

B. Drafted

C. Retired

D. Reviewed

Answer: A

NEW QUESTION 278
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- (Topic 1)
Which are states that you can make a field on a form using Ul Policy?

A. read-only
B. write-only
C. Necessary
D. Mandatory
E. Empty

F. Hidden

Answer: ADF

NEW QUESTION 280
- (Topic 1)
When working on a form, what is the difference between Insert and Update operations?

A. Insert creates a new record and Update saves changes, both remain on the form

B. Insert creates a hew record and Update saves changes, both exit the form

C. Insert saves changes and exits the form, Update saves changes and remains on the form
D. Insert saves changes and remains on the form, Update saves changes and exits the form

Answer: B

NEW QUESTION 282
- (Topic 1)
What are the two pathways to view feedback left on a published article?

A. Knowledge > articles > My Flagged

B. Knowledge base > my knowledge > flagged articles
C. Knowledge > My articles > Flagged

D. Knowledge > articles > published

Answer: AD

NEW QUESTION 283
- (Topic 1)
What is (are) best practice(s) regarding users/groups/roles? Choose 2 answers

A. You should never assign roles to groups.
B. You should assign roles to users.

C. You should assign roles to groups

D. You should add users to groups

Answer: CD

NEW QUESTION 288
- (Topic 1)
Which of the following statement describes the purpose of an Order Guide?

A. Order Guides restrict the number of items in an order to only one item per request

B. Order Guide provide a list of guidelines for Administrators on how to set up item variables
C. Order Guide provide the ability to order multiple, related items as one request

D. Order Guides take the user directly to the checkout without prompting for information

Answer: C

NEW QUESTION 293
- (Topic 1)
What is a way that you can mark a knowledge article for review?

A. Flag article
B. Review
C. Bookmark
D. On Hold

Answer: A

NEW QUESTION 297

- (Topic 1)

Which one of the following statements is true about Column Context Menus?

A. It displays actions such as creating quick reports, configuring the list, and exporting data
B. It displays actions related to filtering options, assigning tags, and search

C. It displays actions related to viewing and filtering the entire list

D. It displays actions such as view form, view related task, and add relationship

Answer: A

Passing Certification Exams Made Easy

visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 PQSS@QSLJ https://www.2passeasy.com/dumps/CSA/ (371 New Questions)

NEW QUESTION 301
- (Topic 1)
Business Rules are used to enforce mandatory data on a form.

A. True
B. False

Answer: B

NEW QUESTION 305
- (Topic 1)

What is the path an Administrator could take to view the fulfillment stage task list for an order placed by a user?

A. RITM (Number)>REQ (Number)>PROCUREMENT (Number)
B. REQ (Number)>RITM (Number)>PROCUREMENT (Number)
C. REQ (Number)>RITM (Number)>TASK (Number)

D. FULFILLMENT (Number)>RITM (Number)>TASK (Number)

Answer: C

NEW QUESTION 306
- (Topic 1)
Knowledge articles within a knowledge base are grouped by category.

A. True
B. False

Answer: A

NEW QUESTION 307
- (Topic 1)
Where would you go in ServiceNow to order services and products offered by various departments?

A. Service Catalog

B. Self Service

C. Service Department
D. Customer Service

Answer: A

NEW QUESTION 311

- (Topic 1)

What is the purpose of flagging an article in a knowledge base?
A. To mark an article to read later.

B. Allow a user to submit feedback about an article

C. Reporting an error

Answer: B

NEW QUESTION 315
- (Topic 1)

Which of the following can be customized through the Basic Configuration Ul 16 module? (Choose three.)

A. Banner Image

B. Record Number Format
C. Browser Tab Title

D. System Date Format

E. Form Header Size

Answer: ACD

NEW QUESTION 316

- (Topic 1)

Which of the following is used to initiate a flow?
A. A Trigger

B. Core Action

C. A spoke

D. An Event

Answer: A

NEW QUESTION 318
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- (Topic 1)
What is a Dictionary Override?

A. A Dictionary Override is an incoming customer update in an Update Set which applies to the same objects as a newer local customer update
B. A Dictionary Override is the addition, modification, or removal of anything that could have an effect on IT services

C. A Dictionary Override is a task within a workflow that requests an action before the workflow can continue

D. A Dictionary Override sets field properties in extended tables

Answer: D

NEW QUESTION 319
- (Topic 1)
Which one of the following statements describes the contents of the Configuration Management Database (CMDB)?

A. The CMDB contains data about tangible and intangible business assets

B. The CMDB contains the Business Rules that direct the intangible, configurable assets used by a company
C. The CMDB archives all Service Management PaaS equipment metadata and usage statistics

D. The CMDB contains ITIL process data pertaining to configuration items

Answer: A

NEW QUESTION 324
- (Topic 1)
What is the difference between Ul Policy and Ul Action?

A. Ul Action can make fields read-only, mandatory, or hidde
B. while Ul Policy can make a save button visible for appropriate users.
C. Ul Policy can make fields read-only, mandatory, or hidde
D. while Ul Action can make a save button visible for appropriate users.

Answer: B

NEW QUESTION 327
- (Topic 1)
Which term best describes something that is created, has worked performed upon it, and is eventually moved to a state of closed?

A. report

B. workflow
C. event

D. task

Answer: D

NEW QUESTION 329
- (Topic 1)
What is a Record Producer?

A. A Record Producer is a type of Catalog Item that is used for Requests, not Services

B. A Record Producer creates user records

C. A Record Producer is a type of Catalog Item that provides easy ordering by bundling requests

D. A Record Producer is a type of a Catalog Item that allows users to create task-based records from the Service Catalog

Answer: D

NEW QUESTION 332
- (Topic 1)
Ul Policy can make fields read-only, mandatory, or hidden.

A. True
B. False

Answer: A

NEW QUESTION 334

- (Topic 1)

Which type of interface enables you to display multiple performance analytics, reporting and other widgets on a single screen?
A. Form

B. List

C. Dashboard

D. Timeline

Answer: C

NEW QUESTION 339
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- (Topic 1)
As it relates to ServiceNow reporting, which of the following statements describes what a metric can do?

A. A metric is a report gauge used on homepages to display real-time data

B. A metric is a time measurement used to report the effectiveness of workflows and SLAs

C. A metric is used to measure and evaluate the effectiveness of IT service management processes
D. A metric is a comparative measurement used to report the effectiveness of workflows and SLAs.

Answer: C

NEW QUESTION 344
- (Topic 1)
What is a formatter? Select one of the following.

A. A formatter allows you to configure applications on your instance

B. A formatter is a form element used to display information that is not a field in the record
C. A formatter allows you to populate fields automatically

D. A formatter is a set of conditions applied to a table to help find and work with data

Answer: B

NEW QUESTION 346
- (Topic 1)
Table Access Control rules are processed in the following order:

A. any table name (wildcard), parent table name, table name
B. table name, parent table name, any table name (wildcard)
C. parent table name, table name, any table name (wildcard)
D. any table name (wildcard), table name, parent table name

Answer: B

NEW QUESTION 349
- (Topic 1)
ServiceNow uses what term to describe all the data saved within a particular form?

A. Fields
B. Form
C. Record
D. Lists

Answer: C

NEW QUESTION 351
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.

D. They provide options.

Answer: B

NEW QUESTION 353

- (Topic 1)

Which one of these applications is available to all users?
A. Change

B. Incident

C. Facilities

D. Self-Service

Answer: D
NEW QUESTION 357
- (Topic 1)

Record numbers have to be manually incremented

A. True
B. False

Answer: B

NEW QUESTION 359
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- (Topic 1)
What defines conditions that are evaluated against users to determine which users can create, read, write, and retire knowledge articles.

A. User conditions
B. User info

C. User Criteria

D. User permissions

Answer: C

NEW QUESTION 360
- (Topic 1)
Which tool is used to have conversations with logged-in users in real-time?

A. Connect Chat
B. Now Messenger
C. User Presence
D. Comments

Answer: A

NEW QUESTION 362
- (Topic 1)
Which three Variable Types can be added to a Service Catalog Item?

A. True/False, Multiple Choice, and Ordered

B. True/False, Checkbox, and Number List

C. Number List, Single Line Text, and Reference
D. Multiple Choice, Select Box, and Checkbox

Answer: D

NEW QUESTION 367
- (Topic 1)
Which statement is true about business rules?

A. A business rule must run before a database action occurs

B. A business rule can be a piece of Javascript

C. A business rule must not run before a database action occurs
D. A business rule monitors fields on a form

Answer: B

NEW QUESTION 368
- (Topic 1)
Ul Action can prompt that an Incident has been successfully submitted.

A. True
B. False

Answer: A

NEW QUESTION 370
- (Topic 1)
Which one statement correctly describes Access Control rule evaluation?

A. Rules are evaluated using role

B. The role with the most permissions evaluates the rules first

C. If more than one rule applies to a row, the older rule is evaluated first

D. If a row level rule and a field level rule exist, both rules must be true before an operation is allowed
E. Rules are evaluated from the general to the specific, so a table rule must be active to continue

Answer: D

NEW QUESTION 373

- (Topic 1)

Data Policy can enforce mandatory data on import.

A. True
B. False

Answer: A

NEW QUESTION 375
- (Topic 1)
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What are the two aspects to LDAP Integration?

A. Data Population
B. Data formatting
C. Authorization
D. Authentication

Answer: AD

NEW QUESTION 380
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD

NEW QUESTION 384

- (Topic 3)

What process allows users to create, categorize, review approve and browse important information in a centralized location that is shared oy the entire
organization?

A. Self Service Management

B. Knowledge Management

C. Knowledge-Centered Management
D. Information Portal Management

E. Business Information Management

Answer: B

Explanation:

Knowledge Management is the process that allows users to create, categorize, review, approve and browse important information in a centralized location that is
shared by the entire organizationl. Knowledge Management helps users to find relevant and accurate information quickly, reduce the need to rediscover
knowledge, and improve the quality of service and customer satisfactionl.

References
? Knowledge Management - ServiceNow1

NEW QUESTION 388
- (Topic 3)
Which role(s) are required to impersonate a user? Choose 2 answers

. admin

. sys_admin

. security_admin
. Sys_user

. impersonator

mooOo®pP

Answer: AE

Explanation:

The admin role is required to impersonate any user in ServiceNow, while the impersonator role is required to impersonate a user who has granted impersonation
access to the impersonator. The other roles are not related to the impersonation functionality. Referencesl: Impersonate a user - Product Documentation: San
Diego - ServiceNow2: Non-admin users with the “impersonator” role cannot impersonate any user if there are orphaned ‘sys_user_has_role’ records like " [user:
null; role: admin]". - Support and Troubleshooting - ServiceNow

NEW QUESTION 393
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category

B. On the Filter Menu, select Group By > Category

C. Click Group On icon, select Category

D. On Navigator Filter, type tablename.group.category and press enter

E. On the Category column title, click Context menu > Group By Category

Answer: AE
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 394
- (Topic 3)
What actions are taken to filter a long list of records to show only those with the Category of Hardware?

A. On Breadcrumb, click the > icon, type Hardware and click enter
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B. On the Category column header, right-click and select Show > Hardware

C. On the list, locate and right-click on the value Hardware, select Show Matching
D. Right-click on magnifier type Hardware and click enter

E. Click Funnel icon, type Hardware and click enter

Answer: C

NEW QUESTION 396
- (Topic 3)
A department manager asks an analyst to build some reports. Where do you recommend the analyst start?

A. Report Dashboard > Create New
B. Reports > Getting Started

C. Performance Analytics > Reports
D. Self-Service > Reports

E. Reports > Create New

Answer: E

Explanation:
Reference: https://kstate.service-now.com/kb_view.do?sysparm_article=KB12492

NEW QUESTION 400
- (Topic 3)
Which is the most efficient way to move large amounts of data between instances?

A. Export to Data Package
B. Export to XML

C. Update Sets

D. Export to Zip

Answer: B

NEW QUESTION 403
- (Topic 3)
What does Natural Language Query allow you to do on a list?

A. Automatically select a filter, based on keywords
B. Filter list by typing in a phrase

C. Predict the filter desired by the user

D. Speak to the condition builder

E. Set list filter, using audible commands

Answer: A

NEW QUESTION 406
- (Topic 3)
Which ServiceNow capability allows you to provide knowledge articles, via a conversational messaging interface?

A. Agent Assist

B. Virtual Agent

C. Now Messenger
D. Connect Agent

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-release-notes/page/release-notes/analytics-intelligence-reporting/virtual-agent-rn.htmi

NEW QUESTION 410
- (Topic 3)
Which admin role is required to make changes to High Security Settings?

A. security _admin
B. sn_ad_admin

C. high_sec_admin
D. admin

Answer: A

NEW QUESTION 413

- (Topic 3)

You have an existing customer, who is using workflows for their catalog items. Their existing purchasing policy is to require approval for any request that totals
over 31000. However, management wants to change the approval threshold to 31500. Which

workflow would you update to make this change?
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A. Services Approval Processing

B. 6 Services Catalog Item Request
C. Service Catalog Request

D. Purchasing Process Flow

Answer: C

NEW QUESTION 415
- (Topic 3)
What do you click when you have made modification to your report, and your want to see the results without saving?

A. Execute
B. Tryir
C. Run
D. Test
E. Preview

Answer: D

NEW QUESTION 417
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the notification

B. The associated knowledge base

C. Under what conditions is the notification sent
D. Who receives the notification

E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 418

- (Topic 3)

When looking at a long list of records, you want to quickly filler, to show only those which have Shon Description containing email
How might you do that?

A. Click List Magnifier to expand column search, on Short Description, type “email, click enter
B. Click List Magnifier to expand column search, on Short Description, lype *email, click enter
C. Click List Magnifier to expand column search, on Short Description, type email, click enter
D. On Search box, select text, type email, click enter

Answer: A

NEW QUESTION 420
- (Topic 3)
What module enables an administrator to define destinations for imported data on any ServiceNow table?

A. Field Transform
B. Transform Map
C. Schema Map
D. Import Map

Answer: B

NEW QUESTION 425

- (Topic 3)

Roles can inherit permissions from other roles. Which role inherits all of the permissions of the catalog role and the user_critena_admm role plus has permissions
to create Items and Services?

A. item Admin [sn_item_admin]

B. Sys Admin [sys_admin]

C. Catalog Admin [catalog_admin]
D. Catalog Auinor (sn_cataiog_write]

Answer: C

NEW QUESTION 426

- (Topic 3)

Which feature can be used to categorize a set of records from a list and make them visible to other users?
A. Tags

B. History

C. Favorites

D. Activity Formatter

Answer: A
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Explanation:

Tags are labels that you can apply to any task record in ServiceNow. You can use tags to categorize, filter, and search records. You can also share tags with
other users to make them visible to others1.

ReferencesUsing tags

NEW QUESTION 428
- (Topic 3)
What access does a user need to be able to import anicies to a knowledge base?

A. Can contribute

B. sn_knowledge_contripute
C. sn_knowledge_import

D. Can import

Answer: A

NEW QUESTION 432
- (Topic 3)
As administrator, what must you do to access feature of High Security Settings?

A. Select Elevate Roles

B. Add security_admin role to your user account

C. Impersonate Security Admin

D. Use System Administrator < Elevate Roles module

Answer: A

NEW QUESTION 435
- (Topic 3)
What are the steps for applying an update set to an instance?

A. Retrieve, Preview, Commit
B. Specify, Transform, Apply
C. Retrieve, Assess, Apply
D. Get, Test, Push

E. Pull, Review, Push

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/hier-update-sets/concept/us-hier- overview.html#us-
hier-overview

NEW QUESTION 437

- (Topic 3)

When would you use the following steps?
* 1, Homepage Admin > Pages

* 2. Right click on Homepage record

* 3. Select Unioad Portal Page

A. To publish a Homepage to the Portal

B. To retire a Homepage

C. To delete a Homepage

D. o To add a Homepage to an update set

Answer: D

NEW QUESTION 438
- (Topic 3)
Security rules are defined to restrict the permission of users from viewing and interacting with data. What are these security rules called?

A. Role Assignment Rules
B. CRUD Rules

C. Scripted User Rules

D. Access Control Rules

E. User Authentication Rules

Answer: D

NEW QUESTION 443
- (Topic 3)
Which allows the creation of a task-based record from Service Catalog?

A. Record Producers
B. Ul Builder

C. Assignment Rule
D. Flow Designer
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E. Ul Actions=

Answer: D

NEW QUESTION 448
- (Topic 3)

What features are available in Knowledge Management, to support continuous improvement on the knowledge articles?

Choose 4 answers

A. Submit KB Errata

B. Add Comments

C. CC Click frowning icon
D. Tag as Helpful

E. Flag Article

F. Rate with Stars

Answer: BDEF

NEW QUESTION 450
- (Topic 3)

How would you distinguish between a Base Class table and a Parent Class table?

A. Base Class tables always have tables extended from them, Parent tables do not have tables extended from them.
B. Base Class table is not extended from another tabl

C. Parent class tables may be extended from another table.

D. Extended tables can be extended from Parent tables or Base tables, but they cannot be extended from both.

E. Extended tables are always extended from Parent tables, Extended tables are usually extended from Base tables,

Answer: B

NEW QUESTION 452
- (Topic 3)

On a filter condition, which component is always a choice list?

A. Operator

B. Filter Criteria
C. Operation

D. Match Criteria

Answer: C

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/common-ui-elements/concept/c_ConditionBuilder.html

NEW QUESTION 456
- (Topic 3)

The Report Designer contains different sections for configuring your report. Which section is used to adjust the look of your report, including colors, files, and

legend layout?

A. Format
B. Layout

C. Style

D. Configure

Answer: C

NEW QUESTION 457
- (Topic 3)

On a filter condition, there is an element, which is based on the table, the user access rights, and columns on the table. What is this element called?

A. Attribute

B. Label

C. Field

D. Column

E. Data Element

Answer: C

NEW QUESTION 461
- (Topic 3)
On a list, what does each row show?

A. A filter
B. A record
C. Atable
D. A field
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Answer: B

Explanation:
A list is a collection of records from a table. Each row in a list represents a record in that tablel.
Referencesldentifying the view used on a list or formServiceNow: List Views for BeginnersHow Do | See A List Of Users And Their Roles In ServiceNow

NEW QUESTION 464
- (Topic 3)
What is the name of the string that display filter criteria?

A. Topic

B. Choice

C. Breadcrump
D. Menu

Answer: C

NEW QUESTION 466
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